Create and Administer a Test
Eduphoria Aware for Teachers
All teachers can create, grade, and analyze their own tests using Eduphoria Aware.
It is also possible to create a campus-level test that can be used as a common unit assessment.
The differences between Teacher tests and Campus tests are described below.
Please Note: If you would like to be able to create Campus Tests, you must receive permission from your principal, and the
Technology Department must give you additional rights in Eduphoria Aware.

Teacher Test

Campus Test

Access rights in Aware

Requires no additional access rights. Can be
created by any teacher.

Assign tests

Teachers can only assign Teacher Tests to
their own students.

Sharing a test

A teacher can share his/her Teacher Tests
with other teachers so that they don’t have
to create the test from scratch.
A Teacher Test can be administered to
students as soon as it is marked active. It
remains available until the teacher marks it
archived.
A Teacher Test is only viewable by the
teacher, and only the teacher can analyze
the results.

To create a Campus Test, you must have special
access rights in Aware. Teacher must have
principal approval to receive additional access.
A Campus Test can be assigned to any student:
by course, by teacher, or by student
characteristics/programs served.
A Campus Test is shared with other teachers by
default. A Campus Test can be shared with
other campuses, if requested.
A Campus Test has a testing window and must
be marked active. It can only be administered
to students during the testing window.

Test availability

Analysis

A Campus Test can be analyzed campus-wide,
must like a TAKS test.

CREATE A TEACHER TEST: QUICK TEST KEY
1. Log in to Eduphoria.
2. Click on Aware.
3. On the far left side of the screen, click the Tests tab.

4. At the bottom left side of the screen, click Create New
Test.
5. Under Create a Test, you have three options:
Create a quick test key – just enter the answers
and TEKS that align
Create a new blank test – create questions,
answers, and TEKS alignment
Copy an existing test – copy a test you created
previously as a starting point for this test.
Select Create a quick test key. Click Next.
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6. Under Title: enter the title of your test.
7. Select a Grade Level.
8. Click Next.

9. Click the plus sign (+) next to the level you teach (Elementary,
Middle School, High School).
10. Click the plus sign (+) next to the subject area you teach.
11. Click the title of the course this test will be given in. This will
allow you to attach the TEKS for the course you selected to
your test.
12. Click Next.

13. Under Build Test Key, enter the number of questions on the
test.
14. Enter the number of responses (answer choices) each
question should have. You can modify these choices later, if
necessary.
15. Click Next.

16. Under Enter Test Key, click the circles to indicate the correct
answers for each question.
17. Click Next.
18. Click Finish.
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GENERAL INFORMATION
1. The general information about your test is located on the General tab. You can view and modify the:
Test Name
Subject Area the test will be displayed under.
Primary Grade Level the test is associated with. If students in your course are in multiple grade
levels, (Example: Grades 9, 10, and 11) just choose one of the grade levels.
Expectation Scores:
o Met is the percentage required to pass the test
o Commended is the percentage required to receive commended performance. (This may
not apply to tests you create.)
Instructions will appear on the second page of your test booklet, if you choose to create test
questions and print them out for students.
Notes are teacher notes about the test administration and are not visible to students.

2. If you make any changes to the general information, click the Save button at the
top of the screen.
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ATTACH ANOTHER COURSE’S TEKS TO THIS TEST
1. While your test is open on your screen, click the Curriculum tab.
2. Click the Add Course button.

3. Click the plus sign (+) next to the level you teach (Elementary, Middle
School, High School).
4. Click the plus sign (+) next to the subject area you teach.
5. Click the title of the course you want to add.

6. Click the Add Course button again.

EDIT EACH TEST QUESTION
1. While your test is open on your screen, click the
Questions tab.
2. Hover your mouse over the first question (on the left)
or the first answer (on the right). A menu appears.
Click the green pencil icon.

3. The question screen appears. Notice that the
Question tab is selected.

Question Text and Answer Choices
You are not required to enter question text or
answer choices. However, if you plan to print
this test for students, you should type the
question in the New Blank Question text box.
You can type the answer choices in the
Response 1, etc. text boxes.
To add more answer choices, type an answer
in the last blank text box. Click the green plus
(+) icon to the right of the new answer choice.
To remove answer choices, click the red X icon
to the right of the answer choice.
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4. Click the Options tab at the top of the question screen.

Test Options
You are not required to modify the test
options. However, if you plan to print this test
for students, you may want to look at this
screen.
You can modify:
o Question Format: Multiple Choice
(choose one), Multiple Selection
(choose one or more)
o Layout: Half-Width or Full-Width
o Page Break: None, Before, After, Both
o Spacing Below: how many line spaces
should be inserted below the question
o Language: English or Spanish
You can specify:
o Modified: Yes or No
o Difficulty level
o Complexity level
o Bloom’s level
o Question Weight: number of times
the question should count
5. Click the Standards tab at the top of the question
screen.

Add TEKS SE, Process SE, & TAKS/STAAR
Objective
Assigning standards to each test question
allows you to analyze student performance.
If you attached the TEKS for more than one
course, under Course, click the drop-down
menu to select the course you want to use
first.
Click on one of the TEKS you want to assign to
this test question.
Click the Select Standard button.
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If the standard you selected is aligned with a
TAKS Objective and a STAAR Reporting
Category, you will have to choose which it
should align with. On the next screen, click
the drop-down menu and select the
appropriate Objective or Reporting Category.
Click the Select button.
To change the Standard, click the Select New
Standard button, and repeat the process.
To add or change the Process Standard, click
Select New Process Standard, and repeat the
process.
You are only allowed to select one Standard
and one Process Standard for each question.
6. When you are finished editing the question, click
Finished.
7. Your question will refresh, and the standards are now
listed on the right next to the correct answer.
8. Click the Save button at the top of the screen.
9. Repeat this process for each question on your test.

REMOVE A QUESTION FROM YOUR TEST
1. To remove a question from your test, while your test is open on your
screen, click the Questions tab.
2. Hover your mouse over the question you want to remove. A menu
appears. Click the green pencil icon.
3. In the bottom left corner of the question screen, click the Remove
button.

ADD MORE TYPES OF QUESTIONS
1. When you click the Add Question button, you can also add other types of questions:
Selected Response is a multiple choice/multiple response question, like you saw
earlier.
Numerical Response is a gridable question which allows students to write in a
grid a numeric response.
Constructed Response allows students to hand write a response. You must
grade these questions by hand.
Resource is a reading passage, graphic, or other item. If you have multiple
questions that reference the same visual item, you can add it as a resource.
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ADD A NUMERIC RESPONSE (GRIDABLE) QUESTION
1. To add a numeric response (gridable) question, click the Add
Question button.
2. Your question is added at the bottom of your test. Click the
drop-down menu and select Numerical Response.

3. The question editing screen appears. Type in the correct
numerical answer.

4. Click the Options tab to specify the number of places before or
after the decimal and other options:
Use floating decimal point: Fixed decimal point or
Floating decimal point
Decimal places before
Decimal places after
Allow negative values
5. Click the Standards tab to add a TEKS SE, Process SE, or
TAKS/STAAR Objective.
6. When you are finished editing the question, click Finished.
7. Click the Save button at the top of the screen.

REARRANGE QUESTIONS
1. To rearrange the questions on your test, hover your mouse
over the question you want to move. A menu appears. Click
the up blue arrow or the down blue arrow icon until the
question is in the position you want it.
2. Click the Save button at the top of the screen.
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SHARE YOUR TEST WITH OTHER TEACHERS
1. You can share your test with other teachers so they can use the same
test and answer key. To share the test, click the Share button at the top
right corner of the screen.
Please note:
Because this is a Teacher Test (which is what you just created),
each teacher can analyze his/her own students’ performance.
Sharing this test is helpful if each teacher wants to modify the
test for his/her class.

2.
3.
4.
5.
6.

However, after sharing, your campus CANNOT analyze the
performance of ALL students who took the test. If your goal is
to have all students taking Algebra I (for example) at your
campus take the same test so that you can analyze campuswide results, you should create this as a Campus Test. You must
have additional rights to create a Campus Test.
In the Search for a User: box, enter the last name of the teacher you
want to share this test with.
Click the Search button.
Click the name of the teacher you want to share the test with.
Click the Send Test button.
A message tells you Your test has been sent. Click the OK button.

7. The other teacher should log into Eduphoria, click on Aware, click the
Test tab, and then he/she will see the test you shared.
The title of the test will be listed, followed by from Your Name.
8. If the other teacher does not want to keep the test you shared with
him/her, the teacher can click on the test title to open it. At the top of
the screen, he/she should click the red X icon to delete the test. Then
click the OK button.
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ADMINISTER TEST: PRINT ANSWER SHEETS, ENTER ANSWERS, OR USE RESPONSE PADS
1. In the top right corner of the screen, be sure that
the Active button is selected. If it is selected, it will
have an orange background.
2. Click the Analyze tab on the far left side of the
screen.

3. Click the Test Available button.
4. A list of your Teacher Tests will appear.
5. For this test, click the blue arrow on the far right
side of the page.

6. A list of your classes will appear. Check the box to
the far right of each class for which you want to
print answer documents.

7. In the bottom right corner of the screen, you have
multiple options for administering this test:
Print Answer Sheets
Enter Answers
Use Response Pads
Start Online Testing
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Print Answer Sheets, Scan Answer Sheets
1. To print answer sheets for students, click Print Answer
Sheets.
2. The File Download window appears. Click Open to open the PDF file that contains all of your students’
answer sheets.
3. Print the answer sheets to the CopyStar (high capacity copier/printer), as this is the least expensive
method of printing.
4. If you need to print an answer sheet for just one student, scroll through the answer documents until you
find the correct page. When you print, select Current page.
Please note: Each answer sheet is coded specifically for this test and for this student. Be sure each
student has the correct answer sheet.
5. After students complete the test, scan their answer sheets into Eduphoria Aware by following the
instructions in the Eduphoria Aware How to Print & Can Benchmark Tests Video, which is posted at
http://www.georgetownisd.org/aware.
You must login to SchoolWires using your computer username and password to see this video.

Enter Answers
1. To enter answers directly into Eduphoria Aware for
students, click Enter Answers.
2. Click the student’s name on the left side of the
page. Enter the answers the student selected.

3. Click the Save button in the bottom right corner of
the screen.
4. Click another student’s name and repeat the
process.

Use Response Pads
1. Your students can use eInstruction CPS student response pads (“clickers”) to enter
their answers. This requires some additional software to be installed on your
teacher computer.
2. If your campus has an eInstruction CPS student response system, and you would
like to use it for an Eduphoria Aware test:
Enter an Eduphoria HelpDesk request so that the correct software can be
installed on your computer
Check out the eInstruction CPS student response system using your
campus’ checkout procedure.
We will assist you with instructions for using the eInstruction CPS to
administer the test.
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